Help Basics

Help Basics introduces you to the basic features of Windows Help. These topics also include practice
exercises so that you can get some experience using Help.

Note: To make Help information easier to read, enlarge the Help window to its maximum size by clicking the
Maximize button or by choosing Maximize from the Control menu in Help. You can exit Help at any time by choosing
Exit from the File menu in Help.

These topics should be viewed in the order they are listed below.

Help Basics
Asking for Help

What Is Help?
Getting Hel

Finding the Information You Want

Using Lists of Topics to Find Information
Using Keywords to Find Information

Viewing Information in the Help Window

Scrolling in the Help Window
Resizing the Help Window

Getting Information from Highlighted Words or Phrases

Displaying Definitions to Get More Information
Getting Information from Cross-References

Working with Help and Your Application

Viewing an Application and Help Together on the Screen
Exiting Help

Shrinking or Closing the Help Window



What Is Help?

Windows Help provides easy-to-use information about your application.
With Help, you can:

* Press F1 to get information quickly.

Search for topics associated with a keyword or phrase.

For example, you can get a list of all topics associated with "saving files."

View Help information while working in your application.

For example, you can follow step-by-step instructions in the Help window while you perform a task in your
application.

*

[To learn more about Help, choose this topic: Getting Help.




Getting Help

In Microsoft Windows applications that have Help, you can get Help by choosing a command from the
application's Help menu or by pressing F1. In some applications, you can also press Shift+F1 to get
Help on a specific command, screen region, or key.

Method Description

Help menu Choose a command from the application's Help menu to get quick access to
different kinds of Help topics.

F1 Press F1 to display the Help Index for the active application. If the Help window is

already open, pressing F1 displays the Index to Using Help.

If supported by the application, pressing F1 displays Help on a selected command,
an open dialog box, or a displayed message.

Shift+F1 Press Shift+F1 to change the pointer to a question mark pointer (if supported by the
application). Then choose a command, click a screen region (for example, a scroll
bar), or press the key or key combination you want Help on.

NOTE: You cannot use Shift+F1 to get Help on unavailable (dimmed) commands. Instead,
select the dimmed command and press F1.

|To learn more about Help, choose this topic: Using Lists of Topics to Find Information.




Using Lists of Topics to Find Information

One way to get to information in Help is by choosing a highlighted topic (underlined and/or green-
colored text). When you choose a topic from a list, you see either specific Help information or another
list of topics.

Suppose you want to find out which keys you use to move a window. You first choose the highlighted
topic that best represents the kind of information you want.

P Try it out

* Click Keyboard in the Practice Help Index below.

Eéﬁf

1 Press Tab to move the highlight to Keyboard in the Practice Help Index below.

2 Then press Enter.
Important: Don't hold down the Enter key, or you may keep jumping from topic to topic.

Practice Help Index

Keyboard
Commands

Screen Regions



Using Keywords to Find Information

As an alternative to looking through lists of topics, you can have Help search for topics associated with a
keyword. For example, if you want Help on saving a file, you can type "save." Help displays all the topics
associated with the keyword "save." You then choose the topic you want to view.

Read the following procedure before you try it. If you try the procedure as you read it, the Search dialog
box may cover the instructions.

To search for a Help topic:
1 Click the Search button in the Help Icon bar.
Or press Alt+S.
The Search dialog box appears.
2 Type the word or phrase you want to find in the Search For edit box.

Or select a word or phrase from the list of keywords.
You can use your keyboard to move quickly to different parts of the list. The list box scrolls automatically to those
keywords that most closely match what you are typing in the edit box. For example, if you type "pr" in the edit
box, the list box moves to the keywords beginning with the letters "pr" (or to the closest match alphabetically).

3 Choose the Search button.
Help displays all the topics associated with that keyword in the Topics Found list box.

4 Select the topic you want to view from the Topics Found list box. If necessary, use the scroll bar to
view more topics.
Or use the direction keys to select a topic, and then press Enter.

5 Choose the Go To button.
Help displays the information for the topic you selected.

P Try it out
* Use the keyword "scrolling" to search for the topic Scrolling in the Help Window. This is the next topic

in Help Basics.

Note: If you try this search and do not get the topic Scrolling in the Help Window, press F1 and choose Help
Basics. Then choose the scrolling topic or choose this topic again to review the Search procedure.



Scrolling in the Help Window

Sometimes you have to scroll to see all the information in the Help window. The vertical and horizontal
scroll bars let you view information not visible in the window.

}% Mouse techniques:

To scroll Do this

Up Click the Up scroll arrow.

Down Click the Down scroll arrow.

Left Click the Left scroll arrow.

Right Click the Right scroll arrow.

Continuously Click a scroll arrow and hold down the mouse button until the information

you want comes into view.

One window up Click the scroll bar above the scroll box.

One window down Click the scroll bar below the scroll box.

One window left Click the scroll bar to the left of the scroll box.

One window right Click the scroll bar to the right of the scroll box.

To the start of the topic Drag the scroll box to the top of the scroll bar.

To the end of the topic Drag the scroll box to the bottom of the scroll bar.

All the way to the left Drag the scroll box to the left end of the scroll bar.

All the way to the right Drag the scroll box to the right end of the scroll bar.
Keyboard techniques:

To scroll Press

Up Up Arrow.

Down Down Arrow.

Left Left Arrow.

Right Right Arrow.

Continuously Hold down a direction key until the information you want comes into view.

One window up PgUp.

One window down PgDn.

One window left Ctrl+PgUp.

One window right Ctrl+PgDn.

To the start of the topic Ctrl+Home.

To the end of the topic Ctrl+End.

All the way to the left Home.

All the way to the right End.
P Try it out

* Scroll down past this instruction box until you reach the end of this topic.

To learn more about Help, choose this topic: Resizing the Help Window.




Press PgUp or Ctrl+Home to scroll up.



Resizing the Help Window

You can resize the Help window to make viewing information easier. For example, you might want to
widen the window to see all the information in a table. You resize the Help window just as you resize any
other window.

4 Try it out
You can try the following procedure as you read it. You can also use this procedure to resize other
application windows.

To resize the Help window:

}% 1 If the Help window is fully enlarged, click the Restore button in the upper-right corner to
restore the Help window to its previous size.
If the Maximize button is in the upper-right corner of the Help window, skip this step.
2 Position the pointer on the border you want to move.
The pointer changes to a two-headed arrow.
Example: Position the pointer on the right border.
3 Hold down the left mouse button.
4 Drag the border in one direction.
Example: Drag the right border to the left to narrow the window.

5 Release the mouse button to fix the new border position.

With a mouse, you can also drag any corner to resize the window vertically and horizontally at the
same time.

1 If the Help window is fully enlarged, choose Restore from the Control menu to restore the
Help window to its previous size.
2 Choose Size from the Control menu.
The pointer changes to a four-headed arrow.

3 Press a direction key to move the four-headed arrow to the window border you want to
move.
The four-headed arrow changes to two-headed arrow.
Example: Press the Right Arrow to select the right border.
4 Use the direction keys to move the border.
Example: If you selected the right border, press the Left Arrow to narrow the window.

5 Press Enter to fix the new border position.

|To learn more about Help, choose this topic: Displaying Definitions to Get More Information.




Displaying Definitions to Get More Information

Within Help topics, you will often see words and phrases that have a dotted underline (and/or color).
Help provides definitions for these words and phrases.

To display a definition:

}@ 1 Point to a term with a dotted underline.
The pointer changes to a hand icon.

2 Press and hold down the left mouse button to read the definition.
The definition disappears when you release the mouse button.

1 Use Tab to select a term with a dotted underline.
2 Hold down Enter to read the definition.
The definition disappears when you release Enter.

4 Try it out
* Select one of the terms with a dotted underline in the Practice exercise below and read its definition.

Practice Exercise

To view a defined term:
1 Position the pointer on the defined term.
2 Press the left mouse button.

|To learn more about Help, choose this topic: Getting Information from Cross-References.




Getting Information from Cross-References

Within Help topics, you will often see words and phrases that are highlighted (solid underline and/or
green color). You can use highlighted words or phrases to move quickly to related Help topics until you
have read all the information you want about a specific feature.

To go to a cross-reference:

}% 1 Point to a word with solid underlining and/or green color.
The pointer changes to a hand icon.

2 Click the left mouse button.
You will see the topic for the highlighted word.

1 Press Tab to select a word with solid underlining and/or green color.
The pointer changes to a hand icon.

2 Press Enter.
You will see the topic for the highlighted word.
P Try it out
* Choose the next Help Basics topic: Viewing an Application and Help Together on the Screen.
Note: To return to the topic where you chose the cross-reference, click the Back button or press
Alt+B.



Viewing an Application and Help Together on the Screen

You can view Help side by side with your application so that while you work, both windows remain fully
visible.

To do this, you resize and arrange the windows so they don't overlap. For example, you might arrange
the windows so that the application is on top of the Help window:

Note: When you start an application and open Help, the Help window appears with the size and location it had when
it was last open.

Try it out

* You can try the following procedure as you read it.

To arrange the application and Help windows:

Complete steps 1 through 3 for the Help window first. Then repeat these steps for the application
window to cover the remaining space on the screen.

Note: Using the mouse method keeps more of the instructions in Help visible as you move and resize the Help
window.

1 If the Help window is fully enlarged, click the Restore button in the upper-right corner to
restore the Help window to its previous size.
If the Maximize button is in the upper-right corner of the window, skip this step.
2 Move the window by dragging the title bar.
3 Resize the window.
Drag a top, bottom, or side border to resize in one direction only.
Drag a corner of the border to resize vertically and horizontally at the same time.
To move to the application window:
* If the application window is visible, click it.

* If you cannot see the application window, press Alt+Tab or select the window from the
Task List.

1 If the Help window is fully enlarged, choose Restore from the Control menu to restore the
Help window to its previous size.
If the Maximize button is in the upper-right corner of the window, skip this step.
2 Move the window: choose Move from the Control menu, use the direction keys to move
the outline of the window, and then press Enter.

3 Resize the window: choose Size from the Control menu, press a direction key to move
to the border you want to move, use the direction keys to move the border, and then
press Enter.

To move to the application window:
* Press Alt+Tab or select it from the Task List.

|To learn more about Help, choose this topic: Shrinking or Closing the Help Window.




Shrinking or Closing the Help Window

When you have finished using Help, you can shrink the Help window to an icon or close it. The Help icon

looks like this:

Winhelp

To shrink Help:
* Click the Minimize button in the upper-right corner of the Help window.

The Help window closes, but the Help icon remains on the desktop. When you press F1, Help
reappears, showing the last topic you viewed.

1 Press Alt+Spacebar to open the Control menu.
2 Choose Minimize.

To close Help:

* Choose Exit from the File menu in Help.
The Help window closes, and Help is removed from the desktop. When you reopen Help, the Help window

retains its size and location.

|To review any Help information, choose the Index button (Alt+l) and choose Help Basics.




You have chosen the Keyboard topic from the Practice Help Index. Now choose the highlighted topic
that takes you closer to the information on moving the window.

Try it out
* Click Movement Keys in the Practice Keys Index below.

1 Press Tab to select Movement Keys in the Practice Keys Index below.
2 Then press Enter.

Practice Keys Index

Deletion Keys
Function Keys
Movement Keys
Selection Keys



The Commands topic gives information about the application's commands. Since you want information
about the keys used to move windows, the Keyboard topic is the best choice.

Try again

* Choose the Back button to return to the Practice Help Index.



The Screen Regions topic gives information about parts of the window and screen. Since you want
information about the keys used to move windows, the Keyboard topic is the best choice.

Try again

* Choose the Back button to return to the Practice Help Index.



You have chosen the Movement Keys topic from the Keyboard list. In this case, you get a list of topics
about movement keys. To find out which keys move windows, choose the topic Moving Windows.

Try it out
* Click Moving Windows.

* Press Enter to see the topic, since Moving Windows is already selected.

Practice Movement Keys Index

Moving Windows
Resizing Windows



The Deletion Keys topic explains which keys you can use to remove information. Since you want
information about keys that move windows, the Movement Keys topic is the best choice.

Try again

* Choose the Back button to return to the Practice Keys Index.



The Function Keys topic has information about function keys and key combinations that include function
keys. Since you want information about keys that move windows, the Movement Keys topic is the best
choice.

Try again

* Choose the Back button to return to the Practice Keys Index.



The Selection Keys topic explains which keys you can use to select information. Since you want
information about keys that move windows, the Movement Keys topic is the best choice.

Try again

* Choose the Back button to return to the Practice Keys Index.



Here you have the information you want on how to move windows. An example of what the keyboard
topic might look like is shown below.

Do not move the window now. Choose this topic to continue: Using Keywords.

Moving Windows

To move an application window or dialog box:
* Choose Move from the Application Control menu.
Or use the direction keys to move the window, and then press Enter to set the position.

To move a document window:
* Choose Move from the Document Control menu.

|To learn more about Help, choose this topic: Using Keywords to Find Information.




The Resizing Windows topic gives information about keys that change the size of a window. Since you
want information about keys that move windows to different locations on the screen, the Moving
Windows topic is the better choice.

Try again

* Choose the Back button to return to the Practice Movement Keys Index.






Help Buttons

Help has five buttons that let you move around easily in Help. If the feature is not available, the button
name and icon appear dimmed.

Button Key Function

Index Alt+l Displays the Help Index for the application.

Back Alt+B Displays the last topic you viewed. Help moves back one topic at a time in the
order you viewed each topic, until you return to the Help Index.

Browse << Alt+R Displays the previous topic in a series of related topics, until you reach the first
topic in the series. Then the button is dimmed.

Browse >> Alt+O Displays the next topic in a series of related topics, until you reach the last
topic in the series. Then the button is dimmed.

Search Alt+S Lists all the Help keywords for the application. By typing or selecting a

keyword, you can search for and go to specific Help topics.

To choose a Help button:

*
*

Related Topics

Point to the Help button and click the mouse button.

Hold down Alt and press the letter underlined in the Help button's name.

Using Lists of Topics to Find Information
Backtracking Through Help Topics

Browsing Help Topics

Using Keywords to Find Information






Help Commands
To get help with a particular command, choose the appropriate menu.

File Menu Commands
Open
Print Topic
Printer Setup
Exit
Edit Menu Commands

Copy
Annotate

Bookmark Menu Commands
Define
(Bookmark Name)
(More)

Help Menu Commands
Using Help
About




Help File Menu Commands

Use the scroll bar to see more commands.

Open
Opens an existing Help file.

Related Topics
Opening Help Files

Print Topic

Prints the topic in the Help window. You can only print entire topics.
Related Topics

Printing Help Topics

Printer Setup
Sets printer options for Help before printing a topic.

You can:
* Select a printer for Help.

* Choose Setup and change options for the printer.
The available options depend on the type of printer selected.

Related Topics

Changqing Printers and Printer Options

Exit

Exits Help.

When closing, Help saves any annotations or bookmarks you created.

Related Topics
Shrinking or Closing the Help window



Help Edit Menu Commands

Use the scroll bar to see more commands.

Copy
Copies the entire text of the current Help topic to the Clipboard.

From the Clipboard, you can paste the text into another application or document.

Related Topics
Copying Help Topics

Annotate
Adds text to the current Help topic.

Annotations are marked with a paper clip icon, which appears above the topic heading.

Related Topics
Annotating Help Topics



Help Bookmark Menu Commands

Use the scroll bar to see more commands.

Define
Places a bookmark at the current topic or removes a bookmark from any topic. The name you specify for
the bookmarked topic appears on the Help Bookmark menu.

(Bookmark Name)
Appears after you have defined a bookmark so you can choose the bookmarked topic you want to
display in the Help window.

(More)

Appears when you have defined more than nine bookmarks. Displays the complete list of names given
to bookmarked topics.

Related Topics

Defining and Using Bookmarks



Help Menu Commands (in Help)

Use the scroll bar to see more commands.

Using Help
Displays the Help Index for the Using Help topics. Choosing this command is the same as pressing F1
or choosing the Index button.

Related Topics

Using Lists of Topics to Find Information
Help Buttons

About
Displays important information about the active application, including the application name, version
number, and copyright notice.






Clipboard

A temporary storage area for cut or copied text or graphics. You can paste the Clipboard contents into a
Windows application.



Control menu

The menu farthest to the left in the title bar. The Control menu appears on every application that runs in
a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.

You use the icon in the Control-menu box to open the Control menu for the window.

= Control-menu icon in application window
= Control-menu icon in document window



defined term
Definitions appear in a window like this.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



direction keys Ll

The four arrow keys on your computer keyboard. These keys are used to move the insertion point, move
and resize windows, select options, and move the highlight in Windows Help. Each direction key has an
arrow on it to show which direction the cursor or pointer will move. Each arrow key is named for the
direction the key points: the Up Arrow, the Down Arrow, the Left Arrow, and the Right Arrow.



Maximize button =1

The small button at the right end of the title bar containing an Up arrow. Mouse users can click the
Maximize button to enlarge a window to its maximum size. Other users can use the Maximize command
on the Control menu.



Minimize button (Al

The small button at the right end of the title bar containing a Down arrow. Mouse users can click the
Minimize button to shrink a window to an icon. Other users can use the Minimize command on the
Control menu.



pointer .

The arrow-shaped cursor on the screen that follows the mouse's movement and indicates which area of
the screen will be affected when you click the mouse button. The pointer usually appears as an arrow,
but changes shape during certain tasks.

A few other pointer shapes: @

X
by

2



Restore button =l

The small button at the right end of the title bar containing both an Up and Down arrow. The Restore
button appears only after you have enlarged a window to its maximum size. Mouse users can click the
Restore button to return the window to its previous size. Other users can use the Restore command on

the Control menu.



scroll arrow

An arrow on either end of a scroll bar that is used to move the contents of the window or list box.
Clicking a scroll arrow moves the contents one line or one screen. Pressing a scroll arrow scrolls the
contents continuously.



scroll bar

A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.

Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.



scroll box

A small box in a scroll bar that shows the position of what's currently in the window or list box relative to
the contents of the entire window.






Help Procedures

The Procedure topics give you step-by-step instructions for using Windows Help. Other procedures can
be found in the Help Basics topics.

Use the scroll bar to see items not currently visible in the Help window.

Procedures

Backtracking Through Help Topics
Browsing Help Topics

Opening Help Files

Copying Help Topics

Annotating Help Topics

Defining and Using Bookmarks
Printing Help Topics

Changing Printers and Printer Options



Backtracking Through Help Topics

Help lets you backtrack through the Help topics you have viewed in the order you viewed them. If there
is no previous topic to view, the Back button appears dimmed. The record of which topics you have
viewed is erased each time you shrink or close the Help window.

To backtrack through Help topics:
* Choose the Back button from the Help Icon bar.
Or press Alt+B.

You return to the previously viewed topic. Help shows the window as you left it unless you resized the window
before backtracking.




Browsing Help Topics

You can view a series of Help topics within a category. For example, you might browse through all these
procedure topics.

To view the next topic in a category:
* Choose the Browse >> button from the Help Icon bar.

Or press Alt+R.
When you reach the last topic in a category, the Browse >> button is dimmed.

To view the previous topic in a category:
* Choose the Browse << button from the Help Icon bar.

Or press Alt+0.
When you reach the first topic in a category, the Browse << button is dimmed.



Opening Help Files
You can open the Help file for any application that uses Windows Help. You do not have to be using the

application to open a Help file. For example, you can be working in Notepad and open the Help file for
Program Manager and read about basic Windows skills.

To open a Help file:

1 Choose Open from the File menu in Help.

2 Select a Help file from the list box, or type the name of the Help file you want to open in the Filename
edit box.
Help recognizes only files with .HLP extensions.

3 Choose Open.
The file appears in the Help window, replacing any Help file you might previously have had open.



Copying Help Topics
You can copy the text of a Help topic onto the Clipboard. From the Clipboard, you can paste the text into
another application or document.

To copy the current Help topic onto the Clipboard:

* Choose Copy from the Edit menu in Help.
To paste the Clipboard contents into another document, use the Paste command in the application's Edit menu.



Annotating Help Topics

You can add your own comments to a Help topic. When you make an annotation, Help places a paper
clip icon to the left of the topic title to remind you that you have added text to this topic.

To add text to the current Help topic:

1 Choose Annotate from the Edit menu in Help.

2 Type the text you want to add in the box provided in the Help Annotation dialog box.
If you make a mistake, press Backspace to erase any unwanted characters and then continue typing.
Text wraps automatically in the edit box, but you can end a line before it wraps by pressing Ctrl+Enter.

3 Choose OK when you have finished the annotation.

To view an annotation:
1 Go to the topic where you made the annotation.
2 Click the paper clip icon.
Or press Tab to highlight the paper clip icon, and then press Enter.
3 Choose OK or Cancel when you have finished reading the annotation.

To remove an annotation:
1 Go to the topic where you made the annotation.
2 Click the paper clip icon.
Or press Tab to highlight the paper clip icon, and then press Enter.
3 Choose Delete.



Defining and Using Bookmarks

Just as you can place bookmarks in a book to mark specific references, you can place bookmarks at
Help topics you use frequently. Once you have placed a bookmark at a topic, you can get that topic
quickly from Help's Bookmark menu.

To place a bookmark at the current topic:

1 Choose Define from the Bookmark menu in Help.

2 Type the name you want to give to the Bookmark in the Bookmark Name box. The choose OK.
Or just choose OK to use the topic title as the bookmark name.
The bookmark name now appears on the Bookmark menu in Help.

To go to a marked topic:

1 Select the Bookmark menu in Help.

2 Choose the topic (bookmark name) you want to view.

Underlined numbers precede the first nine bookmark titles. You can press the corresponding number key to go
quickly to a marked topic.

If more than nine bookmarks have been defined, choose More from the Bookmark menu in Help. Select a
bookmark in the Go To box, and then choose OK.

To remove a bookmark:

1 Choose Define from the Bookmark menu in Help.
2 Select the bookmark you want to remove.

3 Choose Delete.



Printing Help Topics
You can only print entire Help topics.

To print the current topic:
* Choose Print Topic from the File menu in Help.



Changing Printers and Printer Options

Help prints topics on the default printer. If you have installed more than one printer in Windows, you can
make any of your installed printers the default printer. You can also change the default printer options.
To change printers and printer options:

1 Choose Printer Setup from the File menu in Help.

2 Select the printer that you want to change to.

3 Choose Setup to change the default printer options.
The options available depend on the type of printer you have selected.

4 Choose the options you want, and then choose OK.
5 Choose OK again.

Related Topics
Printing Help Topics






Index to Using Help
If you are new to Windows Help, choose Help Basics.
Using Help Topics

Help Basics
Help Buttons
Help Commands
Help Keys

Help Procedures

To choose a Help topic:

4
Mouse * Point to the underlined topic you want to view and click the mouse button.
When the pointer is over an item you can choose, the pointer changes to a hand icon.
4
Keyboard * Press Tab to move the highlight to the underlined topic you want to view, and then press
Enter.
To exit Help:
4
Mouse 1 Point to the File menu and click the mouse button.
2 Click the Exit command.
4

Keyboard 1 PressAlt.
2 Type the letter F.
3 Type the letter X.






Help Keys

Use the following keys in Windows Help:

Key(s) Function

F1 Starts Windows Help and displays the Help Index for the application. If the Help window
is already open, pressing F1 displays the Index to Using Help.

In some Windows applications (such as PIF Editor), pressing F1 displays a Help topic on
the selected command, dialog box option, or system message.

Shift+F1 Adds a question mark to the pointer icon. You can then use the question mark pointer to
choose the command, click the screen region, or press the key or key combination you
want to know more about.

This feature is available only in certain Windows applications. It is NOT available in any
of the applications that come in the retail Windows package, such as Calculator, Write,
and Paintbrush.

Ctrl+Ins Copies a Help topic onto the Clipboard so you can paste it into another application or
document.

Alt+F4 Closes the Help window.






